Contents

Audio interface manual

Contents

Contents

Audio interface and control surface

Audio interface and control surface

Cubase LE Installation overview

Cubase LE Installation overview

R8 audio interface system requirements

R8 audio interface system requirements

Connecting and disconnecting in audio interface mode

Connecting and disconnecting in audio interface mode

Using control surface functions

Using control surface functions

Fader section operation

Fader section operation

Setting the function keys

Setting the function keys

Recording with Cubase LE

Recording with Cubase LE

Importing audio into Cubase LE

Importing audio into Cubase LE

Contents

Audio interface and control surface

Cubase LE Installation overview

R8 audio interface system requirements

Connecting and disconnecting in audio interface mode

Using control surface functions

Fader section operation

Setting the function keys

Recording with Cubase LE

Importing audio into Cubase LE

2

4

6

6

6

7

8

8

9

10

10

10

11

12

12

12

13

14

14

15

16

16

17

18

19

20

20

22

22

24
Mixer in audio interface mode .................................................. 26
  Volume, reverb send, pan ....................................................... 26
  Stereo link .............................................................................. 26
  Balance .................................................................................... 26

Tuner ......................................................................................... 27
  Chromatic tuner ....................................................................... 27

Effects in audio interface mode ................................................... 28
  INSERT effect ........................................................................... 28
  SEND return effect .................................................................. 28

Working with patches ................................................................. 29
  Patch operations ....................................................................... 29
  Patch initialization (factory reset) ............................................. 29

Control surface setup for other DAWs ........................................... 30
  Logic ....................................................................................... 30
  SONAR .................................................................................... 31
  Ableton Live ........................................................................... 32
  Digital Performer ..................................................................... 33
Audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and use the audio interface and control surface functions of the R8 with a DAW and other software.

Functions of the audio interface and control surface

Audio interface

The R8 inputs and outputs can be used as a Hi-Speed USB 2.0 audio interface with 2 inputs and 2 outputs at quality up to 24-bit/96kHz. Effects can be used when the sampling rate is 44.1 kHz, and the unit can be powered by a computer’s USB bus.

Control surface functions

Control surface functions can be used to control DAW software on a computer via USB. Transport operations, including playback, recording and stopping, and physical control of the DAW faders are possible. Furthermore, various other DAW software functions can be mapped to the F1–F5 keys (assignable functions depend on the DAW used).
Supports input from a variety of sources, including guitars, mics and line level instruments

The two onboard jacks include one high-impedance input. Both accept XLR and standard phone plugs and can provide phantom power (24 or 48V). Many sources are supported from high-impedance guitars and basses to dynamic and condenser microphones and line-level devices like synthesizers. In addition, the built-in high-performance condenser microphones are convenient for recording acoustic guitars and vocals.

Versatile effect functions

Built-in insert effects can be applied to specific channel paths, and two-types of send/return effects work via the mixer send/return. These effects can be applied when recording, of course, but they can also be applied to only the monitor output. For example, when recording vocals, you can apply reverb only to the monitor signal to make singing easier.

Comprehensive built-in mixer

Using the mixer, you can make a mix for monitoring. When simultaneously recording guitar and vocals, for example, you can adjust volume balance, panning and reverb levels. Moreover, you can also adjust the balance between the built-in mixer and the sound sent from a computer.

Multifunction tuner

In addition to standard chromatic tuning, the on-board multifunction tuner also supports 7-string guitar, 5-string bass and various drop tunings.
Cubase LE installation overview

To use the **R8** with DAW software, after installing that software, an audio driver must be installed and set to recognize it.* We explain how to do this with Cubase LE.

1. **Audio interface**

By using the **R8** between a computer and external audio devices and instruments, their signals can be recorded using a DAW or other software. Instruments and mics that require high impedance or phantom power can also be connected.

2. **Control surface**

Using the faders and keys on the **R8**, you can control transport operation and mixing in digital audio workstation (DAW) software on your computer.

### Audio interface

- Install DAW software
  - Cubase LE
  - Reference: "Cubase LE Startup Guide"
- Install driver
  - ZOOM R8 audio driver*
- Connect R8 to computer
  - P.8
  - Audio interface setup
- DAW software setup
  - Device setup
    - ZOOM R8 audio driver
  - Control surface setup
    - P.10, 30~
    - Mackie Control

### Control surface

- Recording
  - P.16

*No driver is necessary for use with Macintosh computers.
R8 audio interface system requirements

Windows
Windows® XP SP3 or later (32-bit)
Windows® Vista SP1 or later (32-bit, 64-bit)
Windows® 7 (32-bit, 64-bit)
32-bit: Intel® Pentium® 4 1.8 GHz or faster
64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster
64-bit: RAM 2 GB or faster

Intel Mac
OS X 10.5.8 or later/10.6.5 or later
Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

• USB hubs are not supported.
• Intel® chipsets recommended.

Note about descriptions and images
This manual was prepared based on use with Windows systems. Special functions related to Mac OS X are indicated separately.

The screen images are of the Windows version of Cubase LE.

About trademarks
• The SD and SDHC logos are trademarks.
• Windows®, Windows® XP, Windows Vista® and Windows 7® are registered trademarks of Microsoft® in the USA.
• Macintosh® and Mac OS® are trademarks of Apple Inc.
• Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH.
• Intel® and Pentium® are trademarks of Intel Corporation.
• Mackie Control is a registered trademark of LOUD Technologies.
• Logic is a trademark of Apple Inc.
• SONAR is a trademark of Cakewalk, Inc.
• Ableton Live is a trademark of Ableton AG.
• Digital Performer is a registered trademark of Mark of the Unicorn.
• All other product names, registered trademarks, and company names mentioned in this documentation are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
Connecting and disconnecting in audio interface mode

This is an overview of connecting and disconnecting the R8 to a computer with a USB cable. For details, see the included Cubase LE Startup Guide guide.

**Connecting the R8 to a computer for the first time**

1. Install the Cubase LE DAW software on the computer.
2. Install the ZOOM R8 audio driver on the computer from the included SD card. (No driver is necessary for use with Macintosh computers.)
3. Connect the R8 to the computer.
4. Setup the DAW software.

**NOTE**
- The ZOOM R8 audio driver is essential for using the R8 as an audio interface with DAW software such as Cubase LE. (No driver is necessary for use with Macintosh computers.)
- Download the latest R8 audio driver from the Zoom Corporation website. http://www.zoom.co.jp/

**R8 setup and connection**

1. Connect the R8 to the computer using a USB capable.
2. Press USB.
3. Select AUDIO I/F.
4. Press ENTER. Select EXECUTE.

Reference: "Cubase LE Startup Guide"
**Disconnecting**

1. Press the [ ] below or press [ ].

2. Select YES.

   ![Yes/No Menu]

   - **Terminate**
   - **Are You Sure?**
   - **YES**
   - **NO**

Press ENTER.

---

**NOTE**

Select CONTINUE to use the same settings as last time.

- INSERT EFFECT settings
- SEND RETURN EFFECT settings
- Mixer settings
- TUNER settings

Select RESET to restore default settings for each item.

- The audio interface and control surface functions of the R8 can be used by drawing power through a USB cable from the USB bus.
- We recommend always using the latest R8 system software.
Using control surface functions

When using the **R8** connected by USB as an audio interface, the **R8** keys and faders can be used to control Cubase LE’s transport and mixer.

### About the control surface

In control surface mode, the keys and knobs on the **R8** can be assigned to particular Cubase LE functions.

**HINT**

Assigning keys

For a list of functions that can be assigned to the knobs and keys of the **R8**, as well as other transport/function keys that are supported by Cubase LE, please consult the “Control surface functions quick reference guide” in this manual.

### Control surface setup

See **R8** setup and connection on P.8-9

5. Then, launch Cubase LE.

6. From the Cubase LE “Devices” menu, select “Device setup…”

   ![Device Setup Window]

   Open the “Device Setup…” window.

   At the top left of the Device setup window [+] , [-] and [<>] buttons appear. Click the [+] and select “Mackie Control”

7. Set the MIDI input and output

   **MIDI input:** ZOOM R8
   **MIDI output:** ZOOM R8
Transport section

By setting up the control surface, the **R8** transport section keys can be assigned to individual functions in Cubase LE.

- F1 key
- F2 key
- F3 key
- F4 key
- F5 key

REW key  FF key  STOP key  PLAY key  REC key

Rewind  Fast forward  Stop  Playback  Record

**HINT**

You can connect a footswitch to the **CONTROL IN** jack to start and stop playback, and change effect patches, for example, with your foot when using the **R8** as an audio interface.

Reference: Operation Manual
Using a footswitch  P.113
Audio interface manual

Fader section operation

Using the faders and status keys of the fader section, you can adjust the volume of corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

About banks

After setting up control surface operation, the main parameters of Cubase LE can be operated using the R8 fader and status keys.

A group of tracks operated by the faders and status keys is called a “bank.” With the R8, one bank of 8 adjacent tracks can be controlled.

For example, if fader 1 is assigned to Cubase LE track 1, tracks 1-8 can be controlled as shown in the following diagram.

<table>
<thead>
<tr>
<th>Status keys &amp; Faders</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.1</td>
<td>Tr.2</td>
<td>Tr.3</td>
<td>Tr.4</td>
<td>Tr.5</td>
<td>Tr.6</td>
<td>Tr.7</td>
<td>Tr.8</td>
</tr>
</tbody>
</table>

As the diagram shows, when tracks 1~8 are selected, pressing □ beneath BANK once switches the assignments as shown below.

<table>
<thead>
<tr>
<th>Status keys &amp; Faders</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.9</td>
<td>Tr.10</td>
<td>Tr.11</td>
<td>Tr.12</td>
<td>Tr.13</td>
<td>Tr.14</td>
<td>Tr.15</td>
<td>Tr.16</td>
</tr>
</tbody>
</table>

Push □ beneath BANK
The next lower bank of eight tracks (channels) is assigned to the fader section.

Push □ beneath BANK
The next higher bank of eight tracks (channels) is assigned to the fader section.

Operating the fader section

1. Assign the Cubase LE tracks (channels) that you want to control to the fader section.

2. Use the faders to control the volumes of the corresponding tracks.

   The faders control the volumes of their respective tracks. Change the master volume by moving the Master Fader.

3. To change the function of the status keys for all the tracks, press the soft key for the desired function.

   Use these keys to set the functions of the status keys.
Checking DAW recording levels
Set “REC SIGNAL” (in the INSERT EFFECT menu) to set whether signals are sent to the computer “WET” (with effect) or “DRY” (without effect).

Adjust so that the level meters do not clip (reach 0 dB).

0 dB (clipping)
Setting the function keys

The five keys above the transport keys can be used as function keys (F1~F5) and assigned as desired.

**Function key setup**

1. Open the “Device setup…” dialog in Cubase LE.

2. Select “Mackie Control”.
   Commands can be assigned using the three columns displayed on the right side of the window.

3. From the “Button” column choose the function key (F1~F5) to be assigned a Cubase LE function.

4. Click on the “Category” column for that control.

5. Choose the type of Cubase LE function from the Category pop-up menu.

6. Click on the “Command” column and select the desired Cubase LE function from the pop-up menu.
   The items in this pop-up menu will differ depending on the category chosen.

7. Press the “Apply” button.
## Control surface functions quick reference guide

These functions work with Cubase LE, Cubase, Logic Pro, SONAR, Ableton Live and Digital Performer.

<table>
<thead>
<tr>
<th>Control Section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader section</td>
<td>Status keys</td>
<td>Turns mute, solo or record arming on/off for tracks</td>
</tr>
<tr>
<td></td>
<td>1–8 faders</td>
<td>Controls the volume of the corresponding tracks</td>
</tr>
<tr>
<td></td>
<td>MASTER fader</td>
<td>Master volume operation</td>
</tr>
<tr>
<td>Display section</td>
<td>Soft keys</td>
<td>Change functions of status keys, change banks and end connection (EXIT)</td>
</tr>
<tr>
<td>Transport section</td>
<td>Cursor keys</td>
<td>Performs the same functions as the computer arrow keys&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>DIAL</td>
<td>Moves the project cursor position&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>REW key</td>
<td>Rewind</td>
</tr>
<tr>
<td></td>
<td>FF key</td>
<td>Fast forward</td>
</tr>
<tr>
<td></td>
<td>STOP key</td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td>PLAY key</td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td>REC key</td>
<td>Record</td>
</tr>
<tr>
<td></td>
<td>AUTO PUNCH I/O key</td>
<td>Depends on the F1 key setting</td>
</tr>
<tr>
<td></td>
<td>A-B REPEAT key</td>
<td>Depends on the F2 key setting</td>
</tr>
<tr>
<td></td>
<td>▼ marker key</td>
<td>Depends on the F3 key setting</td>
</tr>
<tr>
<td></td>
<td>► marker key</td>
<td>Depends on the F4 key setting</td>
</tr>
<tr>
<td></td>
<td>MARK/CLEAR key</td>
<td>Depends on the F5 key setting</td>
</tr>
</tbody>
</table>

<sup>1</sup>Scrolls window in Digital Performer<br>
<sup>2</sup>No function in Digital Performer
Recording with Cubase LE

In this chapter, we explain how to record into Cubase LE using the R8.

Create a new project

Copy the ZOOM R8 project templates to the computer.

From the CubaseLE_template folder on the SD card included with the R8, copy the templates to the location where Cubase LE is installed.

For Cubase LE 5, copy them as follows

Windows
C:\Program Files\Steinberg\Cubase LE5\templates

Macintosh
/Applications/CubaseLE5.app/Contents/templates/

1 Launch Cubase LE.

2 Choose “New Project” from the File menu.

The New Project Window where you can choose a new project template opens.

3 Create a new project

If you have copied the R8 project templates to the designated folder, these project templates will be displayed when creating a new project. By choosing these templates you will be able to easily create projects with audio track input and output settings already made for the R8.

Template names and details

ZOOM R8 Mono Recording
Project with Cubase LE mono tracks 1–2 assigned to R8 INPUTS 1–2

ZOOM R8 Stereo Recording
Project with a Cubase LE stereo track assigned to R8 INPUTS 1–2
4 Set the save location and click the “OK” button (“Choose” button on Mac OS X).

The project file save location window is displayed.

![Select directory window]

This will create a new project and the project window where most Cubase LE operations are conducted will open.

5 Create a new audio track

Set-up the audio tracks that were made as follows.

To add a new audio track, select “Add Track” from the “Project” menu and then choose “Audio” from the sub-menu that appears.

![Audio track window]

Select the track input/output bus. The names of the R8 busses assigned in the VST Connections (Devices menu) will be displayed. Click here to choose a different bus from a menu that will appear.

NOTE

The inspector displays information about the track currently selected. If it does not display anything, click on a track to see that track’s status.
Recording With Cubase LE

Connect an instrument

6 Connect an instrument such as a guitar to an R8 INPUT jack and choose an effect patch.

The chosen effect patch will be applied to the signal and can be recorded on the computer via the USB port.

See the following for information about how to set the R8 input signal.

7 Select “Mixer” from the Cubase LE “Devices” menu.

The mixer window opens, showing the channels corresponding to the created tracks and the master channel.

8 Enable track monitoring and recording.

Channel corresponding to an audio track

Master Channel

Click the Monitor button until it appears orange.

Click the record enable button. It will appear red when recording is enabled.

HINT

When the Monitor button is orange, the audio track input level is displayed in the level meter next to the fader. When the Monitor button is off, the audio track output level is displayed.
Adjust the recording level

While playing the instrument, adjust the \textbf{R8} input level and set the Cubase LE recording level.

Check the recording level for Cubase LE by viewing the level meter of the channel that corresponds to the recording-enabled track. Set it as high as possible without making the meter peak. When adjusting the level, do not move the Cubase LE fader, but instead adjust the \textbf{R8} gain.

\textbf{NOTE}

- If the Monitor button is on, the \textbf{R8} input signal and the signal returning to the \textbf{R8} via the computer will both be output from the \textbf{R8} at the same time, creating a flanger-like sound. To monitor accurately while adjusting the recording level, turn the \textbf{BALANCE} knob to \textbf{DIRECT}.
- The meter above shows the signal level after it has been processed internally by Cubase LE. For this reason, a slight delay might occur from the time a string is plucked until the level meter moves. This is not a defect.

After adjusting the recording level, click the Monitor button so that it becomes grey.

This turns off display of the input level, and mutes the signal from the computer to the \textbf{R8}.

When the Monitor button is off, the signal just before it is sent to the computer can be monitored from the \textbf{R8 PHONES} and \textbf{OUTPUT} jacks.

Confirm that the Transport Panel is displayed.

If the Transport Panel is not displayed, select “Transport Panel” from the “Transport” menu.
Recording with Cubase LE

Recording

12 Click the Record button on the Transport Panel to start recording.

As you play the instrument, a recorded waveform is drawn in real time in the project window. To stop recording, click the Stop button in the Transport Panel.

Check the recording (playback)

1 Lower the master channel fader.

2 Click the Go to Zero (|<) button in the Transport Panel to return to the beginning of the project.

3 Click the Play button in the Transport Panel to begin playback.
When using Cubase LE, application performance could become extremely delayed or error messages such as “cannot synchronize with USB audio interface” might be displayed. Should such things happen often, the following measures might improve the situation.

1. **Quit other running programs.** In particular, confirm that many background applications are not running.

2. **Reduce the use of plug-ins (effects, virtual instruments) in Cubase LE**

   If a large number of plug-ins are running, the computer processing capacity might not be able to keep up. In addition, reducing the number of simultaneous playback tracks might be effective.

   If the sound breaks up, please increase the audio Buffer Size (Devices > Device Setup... > R8 driver > Control panel). For details, see Step 5 of the Cubase LE Startup Guide. Moreover, if the application performance is extremely slow and regular computer operation is affected, we recommend quitting Cubase LE and disconnecting the R8 USB port from the computer once, and then reconnecting the USB port and relaunching Cubase LE.

---

**HINT**

If no sound comes out after clicking the Play button following recording, recheck the VST Connections (step 6 in the Cubase LE Startup Guide). In addition, confirm that the **R8 BALANCE** control is set to the center.

4. **Raise the master channel fader to a suitable playback level.**
Importing audio into Cubase LE

By connecting a computer and the R8 with a USB cable and setting the R8 to function as a card reader, you can import audio data as WAV files into Cubase LE audio tracks.

**Importing by drag & drop**

1. Connect the computer and the R8 with a USB cable.

2. Press USB.

3. Select READER.

4. Launch Cubase LE.

5. Open the Cubase LE project into which you want to import audio data.

6. Open the R8 SD card from the computer and open the “AUDIO” folder of the project from which you want to import audio data.
7 Select the file (or files) that you wish to import from the “AUDIO” folder and drag and drop them into the Cubase LE project window.

8 When dragging multiple files at one time, select either “Different Tracks” or “One Track” as the import method.
   Generally, select “Different Tracks” to automatically create one track for each file. The files will be arranged vertically in the project window. Select “One track” to create one track with the audio files arranged horizontally.

9 In the “Import Options” window click the “Copy Files to Working Directory” check box, and click the OK button.

The audio files are loaded into Cubase LE tracks.

HINT
- Project data is stored in folders for each project in the PROJECT folder in the ZOOM_R8 folder. Audio recordings are stored as WAV files in the “AUDIO” subfolders of each project folder. Each AUDIO folder also contains a file called “PRJINFO.TXT” that lists the names of files assigned to tracks.
- Master tracks and stereo tracks are stereo WAV files.
- To copy a WAV file from a computer, copy it to the AUDIO subfolder of the desired project folder. Use the R8 to assign the files to tracks.
Importing audio into Cubase LE

Using the “Import” command

1. Connect the computer and the with a USB cable.

2. Press USB.

3. Select READER.

4. Launch Cubase LE.

5. Open the Cubase LE project into which you want to import audio data.

6. From the Cubase LE “File” menu select “Import” and “Audio File…”

Access the from the computer.

The “Import Audio” window opens.
Select the desired audio file (or files) from the “AUDIO” folder of the project from which you wish to import. Click “Open.”

When importing multiple files at one time, select either “Different Tracks” or “One Track” as the import method.

The audio data is assigned to one or more Cubase LE tracks.

Generally, select “Different Tracks” to automatically create one track for each file. The files will be arranged vertically in the project window. Select “One track” to create one track with the audio files arranged horizontally.

**HINT**
- Project data is stored in folders for each project in the PROJECT folder in the ZOOM_R8 folder. Audio recordings are stored as WAV files in the “AUDIO” subfolders of each project folder. Each AUDIO folder also contains a file called “PRJINFO.TXT” that lists the names of files assigned to tracks.
- Master tracks and stereo tracks are stereo WAV files.
- To copy a WAV file from a computer, copy it to the AUDIO subfolder of the desired project folder. Use the **R8** to assign the files to tracks.
Mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R8 internal mixer. In addition, you can adjust the balance of the sound from the internal mixer and from the computer.

**Volume, reverb send, pan**

You can adjust the reverb send, pan, volume and stereo link settings in the same way as in recorder mode.

Operation is the same as in recorder mode.

(Reference: Operation Manual P.42)

**PAN/EQ menu**

**VOLUME**

Adjust the volumes of INPUTS 1–2.

**REV SEND**

Adjust the reverb send levels of INPUTS 1–2.

**PAN (BALANCE)**

Adjust the pan for INPUTS 1–2.

**NOTE**

The reverb send, pan, volume and stereo link settings are all saved when you end (EXIT) audio interface mode and can be used again the next time.

**Stereo link**

Link INPUT 1 and 2 to handle them as stereo pairs.

**Balance**

In audio interface mode, the balance of the input monitoring signal and the signal from DAW software (the computer) can be adjusted with the BALANCE knob.
The R8 tuner can be used as when in audio interface mode. For details, see the Operation Manual (P.108).

### Chromatic tuner

1. Press **TOOL**.
2. Select **TUNER**.
3. Press **ENTER**.
4. To change the standard pitch, press the **[CALIB]** beneath **CALIB**.
5. Select the standard pitch.

### HINT

- The default value of the standard pitch is 440 Hz.
- Tuners other than the chromatic tuner can also be used.

### NOTE

Tuner settings are saved when you end (EXIT) audio interface mode and can be used again the next time.

### Reference:

- Operation Manual
  - Tuner
    - P.108
Effects in audio interface mode

The R8 insert and send-return effects can both be used when the sampling frequency is set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

**Insert effect**

As in recording mode, you can select the insert location and the insert effect algorithm, as well as the effect patches to be applied to the signal being recorded.

**Send return effect**

When used as an audio interface, the send reverb can only be used for monitoring. As in recorder mode, use the SEND REVERB EFFECT menu to change the patch and use the PAN/EQ menu to set the REV SEND level that adjusts the reverb depth.

---

### INSERT EFFECT menu options

**Select the insert location**

Insert on any INPUT 1–2.

**Apply the effect only to monitoring**

The effect can be set to only be applied to the monitoring signal and to not affect signals recorded in DAW software.

---

### Setting the reverb send level

**REVERB SEND**

Adjust the amount of reverb using the REV SEND level of the PAN/EQ menu.

---

**NOTE**

- Effects can only be used when the sampling rate is 44.1 kHz. At all other times they are turned OFF.
- Insert and send return effect settings are saved when you end (EXIT) audio interface mode and can be used again the next time.

(Reference: Operation Manual P.45)

(Reference: Operation Manual P.89)

(Reference: Operation Manual P.44)

(Reference: Audio interface manual – Mixer P.26)
Working with patches

After making many changes, you can restore a patch to its pre-edited settings by initializing it. This will return it to its factory preset condition.

**Patch operations**
For both insert and send return effects

**Menus used for patch operations**

**Selecting patches**
INSERT EFFECT/SEND REVERB
Select a patch from an algorithm to use an insert or send reverb effect.
(Reference: Operation Manual P83)

**Editing patches (EDIT)**
By adjusting effect module parameters and levels, you can create the desired result.
(Reference: Operation Manual P84)

**Importing patches (IMPORT)**
All effect algorithms (and reverb patches) or a single one can be imported from a selected project on the R8.
(Reference: Operation Manual P87)

In audio interface mode, one complete set of effect data is saved for the mode. There are no project based settings.

**Saving patches (SAVE)**
Edited patches can be saved.
(Reference: Operation Manual P86)

**Initializing patches (INITIAL)**
Patches can be restored to their original factory settings. (This option is only available in audio interface mode.)

**Changing patch names (RENAME)**
The name of the currently selected patch can be changed.
(Reference: Operation Manual P88)

---

**Patch initialization (factory reset)**

EFFECT > INITIAL

1. **Selecting effect type**
   - Insert effect: Press the beneath INSERT.
   - Send return effect: Press the beneath REVERB.

The following example is of an insert effect.

2. **Turn the effect On.**

3. **Select INITIAL.**

4. **Select YES.**

---

---
Control surface setup for other DAWs

You can set up the **R8** as a controller for use with a variety of DAW software besides Cubase LE. Please refer to the manual for the software that you are using.

### Control surface setup

1. Select “Preferences” > “Control surfaces” > “Setup…” from the “Logic Pro” menu.
   
   This opens the “Setup” window.

2. Click on the top left “New” and select “Install” from the pull-down menu.

3. Select “Mackie Designs/Mackie Control/Logic Control” from the list in the “Install” window and click the “Add” button.

   “Mackie Control” will be added to the setup window.

4. Click the “Mackie Control” icon. Then, from the top of the list at the left set “Out Port” and “Input” to “ZOOM R8” using their pull-down menus.

### Function key setup

1. Select “Preferences” > “Control surface” > “Controller Assignments…” from the “Logic Pro” menu.

   This opens the “Controller Assignments” window.

2. From the “Zone” column select “Control Surface: Mackie Control.”

3. Change the functions as you like. Controls F1–F5 correspond to the F1–F5 keys on the **R8**.

   *The above procedures are for Logic Pro 9.*

   *The names of the menus, for example, might be different in a different version of Logic.*

   *Please refer to the manual for the version of Logic that you are using for details.*
Control surface setup

1. Select “Controller/Surface” from the “Options” menu to open the “Controller/Surface” window.

2. Click the “Add” button and open the “Controller/Surface Settings” window.

3. Choose “ZOOM R Series” from the drop-down menu of the “Controller/surface” column.

4. Select “ZOOM R8” in the input/output port column.

Function key setup

1. Open the “Edit” > “Preferences” menu.

2. Click “Customization”.

3. Click “Key bindings”.

4. Click “Locate Key…”

5. Press the F1-F5 key that you want to setup to see the currently assigned function. Change that function as necessary.

For Cakewalk SONAR, installation of a control surface plug-in is necessary. Please install it when installing the driver.

The above procedures are for Sonar X1.

The names of the menus, for example, might be different in a different version of Sonar.

Please refer to the manual for the version of Sonar that you are using for details.
Control surface setup for other DAWs

Ableton Live

Control surface setup

1. Select “Preferences” from the “Option” (Windows) or “Live” (Mac) menu.

   The Preferences window will open.

2. Click the “MIDI” setting tab on the left side of Preferences window to select it.

   The setup window related to MIDI will open.

3. Select “Mackie Control” in the pull-down menu of the Control Surface column.

4. Select “ZOOM R8” from the pull-down menus of the Input and Output columns for both left and right.

5. In the MIDI Ports section below, turn “On” the Remote column button for the “Input: Mackie Control Input (Zoom R8)” item.

Function key setup

1. Press the MIDI button at the top right of the main LIVE window to start MIDI map mode.

2. Interface elements that can be assigned will be highlighted in blue. Click on a parameter that you want to control.

3. Press the F1–F5 key of the R8 that you want to assign to control the selected parameter.

   The above procedures are for Ableton Live 8.

   The names of the menus, for example, might be different in a different version of Live.

   Please refer to the manual for the version of Live that you are using for details.
Function key settings

The functions are already assigned in Digital Performer and cannot be changed.

- **AUTO PUNCH I/O key**: Selects YES in dialog boxes
- **A-B REPEAT key**: Selects NO in dialog boxes
- **(marker) key**: Creates groups/track groups
- **(marker) key**: No assignment
- **MARK/CLEAR key**: No assignment

Refer to sections about Mackie Control dialog boxes and track groups in the manual for the version of Digital Performer that you are using.